Customer Product Release Summary
LFM Server 4.3.0.32
Release Date: 19/07/2016

This document outlines all changes made in the above release of LFM software.
Document Prepared by: Arun Putcha – Trainee Application Consultant
Document Approved by: Jennifer Copple – Senior Application Consultant
Superseded software version: LFM Server 4.3.0.26
LFM Software version numbers: X.X.X.X
First version field denotes general software series number.
Second version field is incremented to track major new feature implementation.
Third version field is incremented to track minor new feature implementation.
Final (fourth) version field is incremented to track error fixes.
PC minimum supported specification:
Processor

Intel Core 2 Duo

Memory

(4x1024) 667Mhz DDR2 Dual Channel ECC

Hard Drive

80GB (7200RPM) Serial ATA11

Optical Drive

16x DVD +/- RW Drive

Graphics card

NVIDIA Quadro FX 2000

Operating system

Windows 7 x64

Network

1GB Ethernet card
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Note for Engineering Users: Any volumes that have been demolished in LFM Server
4.2.0.23 or earlier cannot be restored in LFM Server 4.3.0.32. They must be restored in an
earlier version of LFM Server. If a user attempts to do this in LFM Server 4.3.0.32 they will
receive the following message:
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Enhancements for this release:
Navisworks 2015 and 2016 Support
LFM Server now supports Navisworks 2015 and 2016 (Manage and Simulate only, Freedom is not supported).

SmartPlant Review 2015 Support
LFM Server now supports Intergraph SmartPlant Review 2015.
Speed of volume selection in File (Multi-User) mode increased
Volume selection in File (multi-user) mode is now faster meaning that users can be more productive and
efficient. In our tests we saw a 73% decrease in time taken to select a large volume at subdraw 4 from LFM
Server 4.2.1.16 to LFM Server 4.3.0.12.
AutoCAD 2015 and 2016 Support
LFM Server now supports AutoCAD 2015 and 2016.

Fast-Tagging & Intuitive Mark-Up
Adding intelligence to an asset has never been so easy with simple ‘locate and tag’ functionality. Simply
navigate to the area or item you are interested in, select it and start adding intelligence. Input URL’s (links to
data, websites or documents) and attributes within the BubbleView or import .CSV files for the addition of
multiple entries.
These Markups can be viewed and utilised within LFM Server itself for LFM Server Engineering users.
Alternatively, LFM NetView users can also benefit by consuming the Markups in a linked LFM NetView 4
project.
Increased Interoperability
LFM Server now supports Trimble .TZF, FARO .FWS, Dot Product .DP file formats and links to AutoCAD 2015
and Revit 2015. LFM Server now also outputs to Autodesk ReCap.
Volume Selection in BubbleView
Volumes may now be dynamically selected directly in the BubbleView. Simply click on the button
shown right, click on the area of interest in the BubbleView and manipulate the volume via the blue
drag handles.
Additional Operating Units
Users may now display coordinates and measurement in U.S. Survey feet (decimal) and U.S. Survey feet and
inches (decimal).
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LFM NetView 4 Project Creation
LFM Server can now be used to create and link to LFM NetView 4 projects where users can view scan
BubbleViews via a PC, laptop, tablet or smartphone. Scans may be taken offline for site visits, project reviews or
client presentations. LFM NetView users can also take measurements and view Markups created in LFM
Server.
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General/Server Mode error fixes for this release: 4.3.0.32
Internal
Description
Reference

Solution

B4878

Support Database Detect for clashing in
SmartPlant 3D

Database clash detection is now
supported in SmartPlant 3D. See
Appendix 1 below for instructions on
how to enable this feature.

B5038

Low point cloud density on exported
ReCap (.rcp) files

The point cloud density has been
increased for exported ReCap (.rcp)
files

B5220

SmartPlant 3D - Local clash detection not The issue is fixed. The user is now
working
able to successfully run local clash
detection.

B4373

LFM Server crashes on storing volumes The user is now able to store
in the Project Volumes area when storing volumes in the database
project data in an SQL database
successfully.

B2059

Importing an .lfu file (users file) does not
import any users

Importing an .lfu files now imports the
exported users.

B4562

LFM NetView 4 colour projects are
published in greyscale if colour .jpgs are
not in the same folder as the .ints

LFM Server now checks to see if the
BubbleViews are in colour. If they are
and it cannot find the colour .jpgs in
the same folder as the .int, the user
will be asked to browse to the folder
where the .zfcs are (where the colour
resources should be).

B4815

Elevation floorplans contain black tiles if
the plan is vertical and long/thin.

The elevation floorplans are now
created correctly without any error.

B3815

Importing an .rvm file containing
"MDS/MDU clamped shoes" crashes
LFM Server

The user is now able to import an
.rvm file containing "MDS/MDU
clamped shoes" successfully without
any crash.

B4874

Not able to close LFM Server due to
BubbleViews loading

The user is now able to close the
application when BubbleViews are
loading.

B2992

Demolish and Restore right click options
are enabled on the Volumes Manager
without any volumes being selected

The issue is fixed. The Demolish and
Restore options are now enabled
only when a volume is selected.
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B2017

Clipping Volumes don’t have any
The issue is fixed. The dimensions of
dimensions; Width, Height and Depth are the clipping volume are now being
missing.
shown as expected.

B5297

HyperBubble button not being shown in
Navisworks

The option is now available to switch
to HyperBubble on the LFM Server
toolbar within Navisworks.

B5327

Datasets generated from non-colored
data in LFM Server 4.4 do not show any
points when opened in older versions of
LFM Server

Datasets generated from non-colored
data in LFM Server 4.4 now display
correctly in LFM Server 4.3.0.32.

Gateway Mode error fixes for this release: 4.3.0.32
Internal
Description
Reference

Solution

B4547

HyperBubble textures created from data
The HyperBubble texture quality is
converted in recent versions of LFM Server now improved by eliminating the
has rogue data in the sky
disturbances in the data.

B5036

Cannot change the "location for converted
scans" option in Options > Project >
Gateway

The user is now able to change
the “location for converted scans”
option in Options > Project >
Gateway.

B3052

Importing a .k file ignores the first 2 targets

The issue is fixed. The user is now
able to select the targets when
importing a .k file with the typical
six empty lines at the start of the
file.

B2523

Subdraw value for volume selection is not
It is not possible to control the
respected. Volumes are always displayed at subdraw of a volume in Gateway
subdraw 1.
Mode. Hence the subdraw field
has been removed from the
Volume Selection dialogue in
Gateway Mode.
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General/Server Mode error fixes for previous release: 4.3.0.26
Internal
Description
Reference

Solution

B3026

Clashing does not work for a selection of
items in MicroStation/PDS

The issue is fixed and the user is
now able to perform clash
checking for selected items

B4976

Colour decorators are being created despite The issue is fixed and now colour
no colour files being created
files are being created while
NetView publish

B4827

Application is not supporting .zgl or .xgl,
The issue is fixed and the user is
.rvm and LFX export formats for Projects
now able to re-import LFX files
Objects under Objects Manager Tab and an under projects manager tab
error occurs while re-importing LFX file

B4971

The filtered scan list is empty when a
volume is selected

The issue is fixed and the user
now is able to see filtered scan list
when a volume is selected

B2055

Scan positions not shown in AutoCAD

The issue is fixed and the user is
now able to see Scan positions in
AutoCAD.
Toggling the scan sites in LFM
Server is also effects the AutoCAD
Scan Crosses.

B3848

Floorplan view names are confusing

The issue is fixed and the floor
plan View direction are modified
as North, South, East and West
notation

B1439

Toggling when clash manager is open does The issue is fixed and the user is
not turn clashed objects off. Toggling when now able to toggle the clashed
clash manager is closed does not toggle
objects On/Off
objects on.

B4954

AutoCAD - Add ability to clear clash list

B5000

Pipe diameter measurement doesn't display The issue is fixed and now user
3D pipe
can able to see 3D pipe while pipe
diameter measurement.

B5002

Move the recreation of LFM NetView
information to a command
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can able to see the new option
called 'Clear clash list' in LFM
Clash palette window to clear the
clash list

The issue is fixed
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Gateway Mode error fixes for previous release: 4.3.0.26
Internal
Description
Reference

Solution

B4977

LFM crashes when importing a survey (.crd The issue is fixed and the user is
or .k) file by right clicking on the project
now able to import survey file by
node and using "Import to this group" option right clicking on the project node
and using "Import to this group"
option

B4902

Problems creating a new Register group
depending on license features available

B2812

Volume limited dataset generation does not The issue is fixed and the user is
take the group translation into account
now able to generate dataset with
limited volume and group
translation

B4983

Volume limited dataset generation hangs
with unstructured scans
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The issue is fixed and the user is
now able to creating a new
Register group depending on
license features available

The issue is fixed and the user is
now able to generate dataset with
limited volume in case of
unstructured scans also
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General/Server Mode error fixes for previous release: 4.3.0.24
Internal
Description
Reference

Solution

B2379

Volumes exported are not in correct position The issue is fixed and the user is
when imported into LFM Server
now able to import the volumes in
correct position

B4721

Exporting volumes in ReCap & ASCII format The user is now able to export
fails
volume in ReCap & ASCII formats

B3629

Rotation properties for a volume in
attributes window is displaying as zero
degrees

B3967

Drop down box cuts off long volume names The user now is able to see the full
for LFM NetView project publishing
volume name on the pull down
menu of the LFM NetView project
publishing dialogue

B4087

When volume is exported in ASCII format,
in destination folder .asc file is created of
0KB size

The issue is fixed and the user is
now able to export the volumes
with proper .asc file size

B4146

D-points not created properly while using
"Create LFM D-points" command in PDMS

The issue is fixed and the user is
now able to create D-points using
the command in PDMS

B4366

"Points selection failed" if the user tries to
measure if the 3D points are not loaded

The user is now unable to load a
BubbleView if the dataset is not
loaded. This is a temporary
workaround. Enhancement #4877
(“Consider autoloading the
dataset/presenting a message to
the user when they try to open a
BubbleView when the .lfd is not
loaded”) has been raised to cover
the need for a more
permanent/better solution

B4790

Opening a BubbleView is slow when there
are demolished volumes within a project

The cause of the slowness has
now been identified and removed.
Opening a BubbleView in a project
with demolished volumes is now
just as fast as opening a
BubbleView in a project with no
demolished volumes

B4322

Using the “Show Clash Screenshot” function Cause of crash identified and
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crashes LFM

removed. Function can now be
used successfully

B4789

Progress bar for demolishing multiple
volumes stops after the first volume
demolished

The progress bar now updates for
each volume queued for
demolition

B4424

‘Add’ button in Volume tab is still available
after volumes are passed across for
demolition from CAD are reset

The ‘Add’ button is now
unavailable when the user resets
volumes passed across for
demolition from CAD
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Gateway Mode error fixes for previous release: 4.3.0.24
Internal
Description
Reference

Solution

B2727

Adding a survey resets the pre-registered
scan positions

When a survey file is imported to
the registered scan group, a
warning message appears which
says “The register group already
has registered scans, reset
regeneration?”, thereby informing
the user about the consequences
of this action

B2915

No group menu option to close all open
scans/BubbleViews. If the user has opened
multiple scans/BubbleViews, potentially in
multiple Register groups, they currently
need to select each scan to close
individually

The option to close all
scans/BubbleViews is now
available by right clicking on the
register group. This will also be
applied to any sub groups

B4093

Trying to import .prj files to a project results Data which has been recorded by
in the scan conversion failing with
a scanner that has a third party
“Unknown Error”
import license will now convert
successfully. Data which has been
recorded by a scanner that does
not have a third party import
license will present the error "P20
API license key not valid" in the
attributes window

B4535

“Error in small points file” when generating
an .lfd on an 8 core machine immediately
following scan conversion

B4450

Disabling the 3D scan markers in the
The 3D scan marker option can
Options > User tab also turns of the display now be turned off independently of
of 3D scan data
the 3D scan data display

B4473

LFM crashes on generation of a second
dataset in the same session as the first
dataset generation

LFM now warns the user that they
must close and re-open LFM
Server in order to generate a
second dataset

B3035

Mixing colour and greyscale scans in the
same dataset generation leads to bright
red/green points for the greyscale data

Colour and greyscale scans can
now be mixed correctly on dataset
generation
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following scan conversion
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General/Server Mode error fixes for previous release: 4.3.0.20
Internal
Description
Reference

Solution

B4322

LFM Instant crash upon Show clash
screenshot

LFM no longer crashes if the user
clicks on Show clash screenshot

B4424

‘Add’ icon in Volume tab is not reset

The user now is able to disable the
‘Add’ with reset volume button

Gateway Mode error fixes for previous release: 4.3.0.20
Internal
Reference

Description

Solution

B3035

Mixing greyscale and colour scans on
generation results in incorrectly coloured
points.

Greyscale and colour scans can
now be mixed on generation and
the resulting point cloud is
correctly coloured.

B4450

3D points not displayed in Gateway Mode

3D points and scan locations are
being displayed correctly

B4520

Regeneration of INT files from ZFC's
causes horizontal and arced black stripes.
This also affects the generation of
HyperBubble Resources

The BubbleView now shows
correctly when the user
regenerates INT files from ZFC’s

B4473

"Caught Unknown Error" exception followed Now Dataset generation icon is
with crash during dataset generation for an not highlighted for generating the
existing project
dataset for twice in same session

B3960

The positional coordinates are being
The system translation is now
displayed incorrectly when a .ptx file export displayed correctly. The
is performed.
positional coordinate values are
rightly shown when the .ptx file is
exported. Also, .ptx when opened
in word editor the positional
values are correctly shown which
matches with the scan headers
positional coordinates in LFM.
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General/Server Mode error fixes for previous release: 4.3.0.18
Internal
Description
Reference

Solution

B4471

3D scan markers and point cloud data in
different positions after .lfd generation
resulting due to the system translation not
being applied correctly to the 3D point data.
This resulted in the user being unable to
measure in the BubbleView within the LFM
Server dataset (.lfd).

The system translation is now
correctly applied to the 3D point
data and so the 3D scan markers
and point cloud data are now in
correct place post-generation. The
user is now able to measure in the
BubbleView within the LFM Server
dataset (.lfd).

B4122

During the volume selection process if the
user presses the Enter key on the keyboard
to accept the values in the “Volume
Selection” dialogue – LFM crashes.

LFM no longer crashes if the user
presses the Enter key to accept
the values in the “Volume
Selection” dialogue and the
volume will be processed as
expected. The user can also click
on the OK button in the “Volume
Selection” dialogue to achieve this.

B3862

Selecting a volume category for LFM
NetView floorplans on LFM NetView project
publication causes mismatched floorplans in
the LFM NetView project

The user is now unable to select a
volume category for LFM NetView
floorplans. This will be in place
until support for floorplans for
volume categories is introduced.

B4094

ASCII export limited to 2 million points

ASCII export now limited to 20
million points

B4150

Stored volufmes shift position after closing
and re-opening an LFM project

Volumes now displayed in correct
position after closing and reopening the project

B4371

LFM NetView project publishing does not
work on AMD graphics cards

Option to publish LFM NetView
projects now available for AMD
graphics cards

B3234

LFM log files have stopped recording the
version of the graphics driver

Log files now correctly show the
version of the graphics driver.
Currently on line 10

B2381

Newly created projects are not entered into
the “Open recent” menu

Projects are now added to the
“Open recent” menu on creation
rather than having to open the
project manually in order for it to
go into the “Open recent” menu
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B1344

Some options (e.g. “Context clearance” and Options now display in Feet and
“Clipping planes” shown in decimal feet
Inches (fractions)
when IO Units set to Feet and Inches
(fractions)
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Gateway Mode error fixes for previous release: 4.3.0.18
Internal
Reference

Description

Solution

B4265

LFM crashing on scan conversion

Crash now fixed, scans can now
be imported successfully

B2631

BubbleView display a black “shadow” that
tracks the movement of the BubbleView
resulting in the user being unable to see
data that is close to the scanner. This is
caused by the BubbleView near clipping
plane being set to 30cm

BubbleView near clipping plane
now set to 1cm so the black
“shadow” is removed and data
can be seen correctly

B4376

.ptx files with both intensity and colour
values do not display any 3D points if all
intensity values are set to 0

3D points now display correctly
according to the colour values

B2812

Volume limited dataset generation does not
take the system translation into account –
tells the user that no points intersect with
the selected volume

System translation now applied –
the volume that the user
specifies is now in the correct
position and intersects with the
point cloud data as expected.

B4353

After importing .zfc files, the right click
menu on a scan displays “Hide
BubbleView” even though the BubbleView
is not displayed

Right click menu now displays
“Show BubbleView”

B4349

Importing existing .zfc files sometimes
causes LFM to hang

Existing .zfc files can now be
successfully imported

B4364

LFM prompts the user to name the group
but not to save the project before
continuing with generation.

LFM now prompts the user to
save the project and name the
group before proceeding with
generation.
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General/Server Mode error fixes for previous release: 4.3.0.13
Internal
Description
Reference

Solution

B 3258
B 4091

LFM crashes when trying to connect to
LFM now warns the user that the
SmartPlant Review if the SmartPlant Review Point Cloud Integrator module is
Point Cloud Integrator module is not installed not installed

B 4067

Project loading hangs at 99% for a long time

Speed of project loading is now
increased and there is no delay
at 99%

B 2136

Changing the view direction in AutoCAD
2014 clips the point cloud

The full point cloud is now
displayed correctly after
changing the view direction

B 4124

If the project is read only, LFM warns the
user of this when they open the project even
though this only affects demolition

LFM now only warns the user if
they attempt to carry out
demolition

B 4023

Zoom to extents zooms to the project extents This function will now zoom to
when a volume is selected in the SmartPlant the extents of the volume if a
review CAD link.
volume is selected. If no volume
is selected it will zoom to the
extents of the entire project.

B 3982

Volume selection is centred around the
LFM will now give a “point
wrong point if the user clicks on a position not selection failed” message if the
containing a 3D point
user tries to create a volume by
picking on a position where there
is no 3D point

B 2897

Points not shown in AutoCAD after initial
connection until the zoom extents command
is used

B 4022

LFM does not use/update an existing options LFM will now use and update
file. This means that some users who are
and existing options file so the
upgrading from an older version are unable
upgrade route is more seamless
to save their options

B 4056

BubbleView is loaded but not brought to the
front when dragging a scan into the main
area
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Points now display correctly after
initial connection – zoom to
extents no longer needs to be
used in order to show the point
cloud

BubbleView is now loaded and
brought to the front when
dragging a scan into the main
area
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B 4125

Ability to toggle scan sites on/off from the
main LFM interface rather than the options
tab
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There is now a “Scan Sites”
button on the bottom toolbar
which allows the user to toggle
the scan sites on/off
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General/Server Mode error fixes for previous release: 4.3.0.7
Internal
Description
Reference

Solution

B2726

If the units in SPR are switched to be
different from the ones the .vue file was
created in the point cloud will not be
scaled correctly

Scaling now correct if the user
switches units to be different from
the ones the .vue file was created
in

B2810

The desired project must be loaded in
LFM Server before the connection to
SPR can be made successfully

The desired project no longer
needs to be loaded in LFM Server
prior to connecting to SPR. The
desired project is now loaded
automatically after the user
connects and specifies the
location of the project using the
Add Model button

B4011

Show BubbleView from picked point in
SPR CAD link does not load the
BubbleView

Now loads the most appropriate
BubbleView for the point picked

B3912
B2303

Define volume around an element
function in the SPR CAD link returns an
incorrect volume

Volume returned is now around
the selected element with the
appropriate volume padding

B3970

Clash clearance and demolition
Both of these option can now be
clearance options cannot be set to below set to a minimum of 0 and a
2 inches
maximum of 4 inches

B3999

A temporary .pts file is not being deleted This temporary .pts file is now
on successful completion of volume
deleted when the export is
export to Autodesk Recap format
successfully complete

B4001

Z depth of point cloud is incorrect when
overlaid with an existing drawing in
AutoCAD in 2D wireframe visual style

A warning is now presented to the
user when this mode is selected.
All other visual styles are now
supported to compensate for this
but performance may be impaired
when using these visual styles

B1375
B1950

Terminology inconsistency

Changed various terms on the
LFM interface to make them
consistent/more clear
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Gateway Mode error fixes for previous release: 4.3.0.7
Internal
Description
Reference

Solution

B1586
B2712
B3454

LFM crashes on converting certain .ptx files The files that have been
provided to LFM to show this
issue now convert successfully

B3774

LFM does not automatically run the
Prepare for PDMS function upon dataset
generation. This means service providers
have to do this manually to deliver to clients
using PDMS clashing
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LFM now runs the Prepare for
PDMS function automatically
upon dataset generation. Client
can use the dataset for clashing
in PDMS straight away
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General/Server Mode error fixes for previous release: 4.3.0.6
Internal
Description
Reference

Solution

B690

AutoCAD crashing on exit after LFM
CAD link has been used

AutoCAD no longer crashes on exit
after LFM CAD link has been used

B3911

CAD link point size reset back to 1 on
LFM close

The value for this option is now
maintained the next time LFM
Server is used

B2136

Changing the view direction in
AutoCAD 2014 clips the point cloud

All points now displayed correctly

B2897

Points not initially shown in AutoCAD
Points now displaying correctly on
unless zoom extents command is used intial connection. Zoom to extents
no longer required

Gateway Mode error fixes for previous release: 4.3.0.6
Internal
Description
Reference

Solution

B2713

Registration status tab is slow to use
with a large number of scans

Usage is now much quicker with
large number of scans

B3910

LFM crashes when scan attributes
undergo changes through Unify Group
Properties

This function can now be used
successfully

B3136

Unstructured .e57 files fail to convert
giving “image size error”

Error message now provides more
useful information: “This data is
unstructured and is currently not
supported”. Request for
unstructured data support raised as
#3921

B2121

LFM crashes on import of monochrome Monochrome .e57 files can now be
.e57 files
imported to LFM successfully

B3881

Points from scans not displayed inside
volume if the user does not manually
load the BubbleView for that scan
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LFM now loads the BubbleView
automatically when a volume is
requested that contains that scan
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Product QA cycle:
The LFM Software development philosophy uses AGILE principles to ensure a high quality
product which evolves to match customer requirements. Throughout the development cycle,
test and evaluation is used to guide the process and minimise the final test overhead.
The final test process has three stages, and this document has been prepared after these
have been completed. These stages are outlined below.
Individual Function Test
All LFM desktop functionality is examined for correct responses. Functions called from the
Main Menubar, Main Toolbar, Modelling Toolbars, and Component Browser are tested in
turn. This ensures that the functionality matches the design intent, and previously recorded
errors have been fixed.
Destructive Test
This section of the test schedule is aimed at investigating to see if a software product exhibits
proper behaviour when subjected to improper usage, or improper input. The tests are
applied to different data samples, machines, and in a random manner to try to replicate 'real
world' variations in user conditions.
Software Acceptance Tests
LFM Software concludes the LFM test cycle with a series of controlled examples aimed at
simulating real life use situations. The finished models are QA checked against calibrated
historical data, to ensure that the product maintains the previous output standard.
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Appendix 1 -Settings for Database Detection in S3D CAD link
SmartPlant 3D (S3D) is able to run a database clash detection service on any S3D project to
allow the user to identify issues in there model. This steps below will detail the steps that are
required in order to run the SmartPlants database clash detection with an LFM Server point
cloud. It will be assumed you are already familiar with setting up a standard S3D clash
detection server and that you already have some projects setup with LFM Server point clouds
attached.
1. Stop the IFC service
Note: The S3D Database clash detection is unable to clash point cloud data when it is being
run as a standard service. To allow it to clash point cloud data it needs to be run as a process
instead:


Navigate to “Control Panel > All control Panel Items > Administrative Tools > Services”



Turn off “SmartPlant 3D Interference Detection Service”

2. Create IFC process batchfile


Navigate to “C:\Program Files (x86)\Smart3D\FoulCheck\Middle\bin”



Create a batch file called “IFCStart.bat” with the following contents:
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3. Run the IFC process batchfile


Run “IFCStart.bat” as Administrator (this can be setup as a scheduled task if required)



If you open the task manager you should see 1 instance of the “IfcNtSvc.exe *32”
running which indicates that the S3D clash detection is ready

4. Configure the Database Clash Settings


Open S3D Project Management



Select “[project] > Interference Server > properties”



Setup the “Interference Server Settings” as you wish but ensure that the “SP3D –
PointCloud” box is checked
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Click “Start”



After a few moments an “IfcProcess.exe” with start running, then LFM Server will start
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5. Allow multiple clash detections on 1 Server (optional)


Requirements: LFM Server 4.3.0.31/4.4.0.15 or greater



Note: This last step is only valid if you want to use one server to run the clash
detection for multiple S3D projects with LFM Server point cloud data



Open Regedit.exe



Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\LFM
Software\lfmserverAPI.dll\4.4.0.0\IfcProcess.exe



Change the “CadlinkMultiConnection” key to “1”
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This will instruct LFM Server to allow multiple S3D-LFM pairs so that the several clash
detections can be run in parallel.
Note: Although there should be no limitation on how many instances of LFM Server can be
run on one machine, be aware that the database clash detection can take a lot of resources
so choose a server appropriate for the amount of projects you wish to run at once.
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